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Preface

Preface

About the book

It’s been said that, “less is more,” but in our information-overload world, there is no shortage of
resources for learning about whatever subject one desires. It can be tedious sorting through the
mountains of content we're often confronted with when simply trying to learn a few key steps of
how to do something. As with learning any computer application, learning Joomla! CMS can
also be tedious because, though there's a lot of information out there, at times, it's perhaps a bit

too much information.

That’s the inspiration for this book. While Joomla! CMS is a sophisticated web application with
far-reaching capabilities, it’s not necessary to learn everything about Joomla! in order to carry
out some basic tasks of content management. This book seeks to help you sort through Joomla!'s
basic and advanced features and guide you on the fundamentals to get you started managing your

web site’s content quickly.

Who this book is for

This book assumes you already have a Joomla! web site installed, and you just need a little
guidance getting up to speed quickly for carrying out basic tasks, like adding pages, content,
setting up menu items and understanding global parameters. Consider this book a Who, What,
Where lowdown with a smidgen of detail for added bonus, but without bogging you down in

endless details.

If you own a Joomla! web site or are charged with maintaining content in one, but you are not a
web site designer or developer, then this book is for you. If you don’t write HTML and CSS and
prefer to avoid having to learn, then this book is a good fit. If you’ve had some exposure to

Joomla! but get confused using the admin area, exhale, this is your book.

What this book is not

This book is not an in-depth guide to Joomla!. This book does not cover things like installing

Joomla!, setting up the database, debugging errors, third-party applications, template
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customization or system configuration. Most likely you have a web site developer in-house or on

retainer who deals with the higher-level tasks and debugging when things go wrong.

Advanced topics are covered in overview only, just to help give you a general understanding of

how some of Joomla!’s functionality is “hooked together.”

What else this book is not

This book is not a set of tutorials in that the chapters lead to building a web site step-by-step.
There are plenty of resources online and in print for that type of learning. This book takes an
approach of understanding that your first few times encountering the Joomla! Admin site can
seem overwhelming. This book aims to cut through the clutter and show you the most basic areas

of the Admin that you need to know in order to add, edit and show content on your web site.

How this book is structured

Each section in this book is about one functional area of the Joomla! Admin. The sections are

structured in a Who, What, Where and Details fashion:

Who tells which user levels have access to the functional area described.

What gives a brief description of the functional area.

Where describes how to navigate to the functional area.

Details is an expanded description that may include step-by-step instructions or example

workflows.

Tips are related side notes that offer additional information, but are not critical to understanding

the topic of the section.

This book uses bold and italicized text. Bold text generally refers to control items or functional
areas (i.e. Article Manager; Menu Manager). [talicized text generally denotes the name of
interface items (the Options button), field attributes (Featured: Yes; Status: Published) or items
with multiple levels or settings (the Administrator user; the Archived state). Joomla! screenshots

relating to the topics described are found at the end of each section.

i1
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User access requirements

To get the most out of this book, you should have a user profile registered in your Joomla! site so
that you can log in to the administration area. Your user level must be at least Manager, but
preferably Administrator or Super User. If you do not have a user profile with at least one of

these access rights, ask your web site’s administrator to create a user for you.

Be sure to review the Glossary so that you understand some of the terminology used in this book.

Reader feedback

The very idea for this book was born out of a need in the Joomla! user community to have a
“down-and-dirty” guide to some Joomla! basics. As such, we welcome your feedback on the
topics covered in this book and any other topics you would like to have covered. You may

contact us at the book’s dedicated web site, http://basicsofjoomla.com.

i



Glossary
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CMS

Content Management System.

Joomla!

A free, open-source Content Management System written in PHP and
MySQL. The exclamation point is part of the name, “Joomla!”

1.7

Joomla! version described in this book. (Older versions are 1.0, 1.5 and 1.6.)

URL

Universal Resource Locator (a web site address).

Address bar

The field in your web browser where web site URLs display.

Back-end

Joomla! term for the administrative area of Joomla! CMS, The Admin.

Front-end

Joomla! term for the main web site portion of Joomla! CMS, The Site.

Article

Joomla! term for a content item that contains text, images and other media.

Featured
Articles

Joomla! term for Articles published to the “home” page.

Nav/Navbar

Web development terms for a menu that allows site navigation.

Menu Item

Joomla! term for items in a menu.

Parent/Child

Computer term describing a hierarchical relationship between items/objects.

Modal window

A window that displays within the current page while it remains displayed
faded out in the background. In the Joomla! Admin, modal windows often
contain a dialog box.

Published

Joomla! term for displaying items, usually in relation to Article and Menu
Items, and Modules.

Unpublished

Joomla! term for hiding items, usually in relation to Article and Menu Items,
and Modules.

Enabled

Joomla! term for running extensions, usually Plug-ins.

Disabled

Joomla! term for stopping extensions from running, usually Plug-ins.

Asset(s)

Web development term(s) for item(s) on a web page (i.e. text, images,
videos, etc.).
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Chapter 1: The Basics

In this chapter we introduce some concepts of Joomla!, including a brief description of Joomla!’s

structure of “two sites in one” and a couple of Admin-site interface items, the Control Panel and

the Joomla! Toolbar.
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What is Joomla!

Joomla! (the exclamation mark is part of the name) is a free, open-source content management
system and a development framework for building web sites. Joomla! can be used in a very basic
way to display pages of text and images, or be developed into a sophisticated web application

with advanced functionality. Joomla! is available for download at http://www.joomla.org.

Two sites in one

One of the most fundamental things to understand about Joomla! is that it’s actually two sites in
one —the front-end site that you show to the world, and the back-end Administration site where

you manage the front-end site’s content and functionality.

Under a standard Joomla! install, the front-end site is found at http://yoursite.com (where

yoursite corresponds to your web site’s domain name), and the administration site is found by

adding /administrator to the end of your site’s URL (i.e. http://yoursite.com/administrator).
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The Control Panel, your “home base”

Who

Managers, Administrators, Super Users

What

The Control Panel is the main “dashboard” where various areas of the Administration site can be

accessed, and where basic demographics and site activity are displayed.

Where

If not logged in: Administration site > Log in

If logged in: Site > Control Panel. Or via the Administration heading link
Details

The Control Panel is the first screen you see after logging into your Joomla! Administration site
and serves as your “home base.” Once logged in, it can always be accessed via the Site menu or

by clicking the Administration heading in the top left of most Admin screens.

As your “home base,” the Control Panel provides shortcut icons to some of the main areas of the
Administration site to manage content or adjust global settings. The Control Panel also displays
basic site demographics and activity, including a list of logged in users, the most popular content,

and the most recent content added and by whom.

Depending on your user level, Manager, Administrator or Super User, determines what you have

access to and how many shortcut icons you see.

For instance, if your user level is Manager, you will have shortcut icons to the Article Manager,
Category Manager and Media Manager, but will not have access to system settings,
templates or languages. If your user level is Administrator, you will see shortcut icons to some
of these more advanced areas. If you area a Super User, your access is unrestricted. Super Users
have rights to manage high-level system areas, like Global Configuration settings and all user

accounts—even user accounts of other Super Users.
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Figure 1.1: Control Panel with Manager access level

Administration
Site Content Components Help 4 None Logged-in frontend  #L 2 Logged-in backend =" Mo messages [ View Site o Log out
S my » Last 5 Logged-in Users
[+ ] — » Top 5 Popular Articles
Add New Article Avticle Manager Category Manager Media Manager b Last 5 Added Articles
Edit profie

Joomlal® is free software released under the GNU General Public License. Version 1.7.0
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Figure 1.2: Control Panel with Administrator access level

Administration

Site Users Menus Content Components Extensions Help “& None Logged-in frontend %L 2 Logged-in backend = Mo messages L View Site o Log out

» Last 5 Logged-in Users

-— m
[+ N— » Top 5 Popular Articles
Add New Article Avticle Manager Category Manager Media Manager b Last 5 Added Articles
—_— =
e « = @
Menu Manager User Manager Meodule Manager Extension Manager

& = o

Language Manager Template Manager Edit profile

Joomlal® is free software released under the GNU General Public License.  Version 1.7.0
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Figure 1.3: Control Panel with Super User access level

Administration

“& None Logged-in frontend &2 Logged-in backend = No messages 8 View Site o Log out

Site Users Menus Content Components Extenslons Help
S my » Last 5 Logged-in Users
[+ N— » Top 5 Popular Articles
Add New Article Avticle Manager Category Manager Media Manager b Last 5 Added Articles
Menu Manager User Manager Meodule Manager Extension Manager
i K — 6
o)
) 9, v
Language Manager Global Configuration Template Manager Edit profile

Joomlal® is free software released under the GNU General Public License.  Version 1.7.0
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The Joomla Toolbar

Who

Managers, Administrators, Super Users

What

A large toolbar of icons

Where

Top right of most Admin site screens

Details

All Admin screens except for the Control Panel contain the Joomla! Toolbar. This is a toolbar
of colorful icons in the top right. The toolbar buttons are specific to the functional area where
you are currently working, and specific to your user type (i.e. Manager, Administrator, Super

User). Some control items that are common on many screens include New, Edit and Publish.

Figure 1.4: Article Manager: Articles toolbar (Manager level view)

0O OO0 1 ! v W

New Edit Publish ~ Unpublish  Featured Archive CheckIn Trash

Figure 1.5: Menu Manager: Menus toolbar (Super User level view)

OO RRC &

New Edit D};Icm Rebuild Options
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Chapter 2: Managing Content and Menus

In this chapter we get describe how to add, edit and display content on your web site. In the most

basic terms, Joomla! content has two sides to it:

1) The actual page where your text and images reside.

2) Navigation menus with links to the pages that contain your text and images.

In this chapter we cover not only your site’s pages and menu links but also how to organize your

pages in to Categories, and how to use Global Check-in to “unlock” locked items.
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Global Check-in

Who

Administrators, Super Users

What

Check-in and “unlock” checked-out “locked” items.

Where

Site > Maintenance > Global Check-in

Details

One often overlooked function in Joomla! that can save a lot of headaches and frustration is the

Global Check-in.

In Joomla!, only one user at a time can edit an item. For instance, if user! is editing an Article,
no other user will be able to edit that Article at the same time. Other users will simply see an
icon of a locked padlock at the item’s title, indicating that the item is not available, or Checked

out by the user who is editing it.

In order for the Article to be available for another user to edit, user! must Check in the Article
by exiting it in a way that Joomla! approves—by clicking either Save and Close, Save and New
or Close. If a Joomla! item is not exited in one of those ways, it will remain locked, much to the

chagrin of other users, who may need to edit the item.

An item is exited improperly when a user who is editing it simply closes the browser window or
otherwise navigates away from the editing screen other than by saving or closing the item. If this

happens, there are only two ways to unlock the item:

1) Find the user who last edited the item, ask him or her to log in to the admin, enter that

item and properly save or close it.
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2) Global Check-in! Administrators and Super Users can check in all items that are
checked out by other users. On the Site menu, navigate to Maintenance > Global

Check-in. That’s it! Once you click that menu item, a command is sent to Joomla! that

will check-in and unlock any items that are checked-out.

Figure 2.1: Checked out (locked) item

— ™ Contact Info
N [ : contact-info)

Figure 2.2: Accessing Global Check-in via menu navigation

Administration
| Site ‘ Users Menus Content Components Extensions Help
g3 Control Panel
% My Profie
|-|.: Maintenance ||~ Gilobal Check-in - " 1 |
O Logout (* Clear Cache
SO0 NEW AITICIE ] Category Manager Media Manager
Purge Expired Cache

Figure 2.3: Checked-in (unlocked) item

— Contact Info
R : contact-info)
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Categories

Who

Managers, Administrators, Super Users

What

Organizes Articles into groups (similar to the way files are organized into folders)

Where

Content > Category Manager

Details

All Joomla! Articles must live in Categories. You can create as many categories as you like by
navigating to Content > Category Manager > Add New Category, or by clicking the New button

from the Category Manager: Articles screen.
Whether creating new categories or editing existing categories, you can specify whether the

category should be a parent or child of another category. This is analogous to “nesting”

folders—organizing folders inside of other folders.

11
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Figure 2.4: Category Manager access via Control Panel (Manager level view)

Administration

Site Content Components Help 4 None Logged-in frontend  #L 2 Logged-in backend =" Mo messages [ View Site o Log out

1 » Last 5 Logged-in Users
[+ ] » Top 5 Popular Articles
Add New Article Avticle Manager Media Manager b Last 5 Added Articles
Edit profie

Joomlal® is free software released under the GNU General Public License. Version 1.7.0

Figure 2.5: Category Manager access via menu navigation

Administration

Site | Content | Components Help

Article Manager 3

+ Category Manager L2 Add Mew Category
&) Featured Articles

Media Manager —
Add Mew Article Article Manager Category
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Articles

Who

Managers, Administrators, Super Users

What

A Joomla! item that contains content, text, images, etc.

Where

Content > Article Manager

Details

The most basic web page in Joomla! is an Article, where you can add paragraphs of text, insert
images and other forms of media. (Note: adding advanced media, such as Flash, videos or
advanced scripting objects may be limited to your particular site’s settings or hosting

environment.)

How to create a new Article
To create a new Article, simply navigate to the Article Manager and click the New button in the

toolbar. The Article editing screen asks for some information that’s relatively self-explanatory.
For more information about the various fields in the Article editing screen, hover the mouse

pointer over the field labels and Joomla! shows you a “tool tip” description of the fields’ usages.

Title: This is a human-readable title for your article. It also serves as the headline of the article

when viewed on your web site.

Alias: This is a browser-readable version of the Article’s title that can be used as part of the URL
to the article (with SEF URLs turned on in the Global Configuration). The alias should not
contain any spaces. Use dashes or underscores in place of spaces. Mixed case is ok, but all lower
case is preferable. You may leave the alias blank and Joomla! will insert an alias for you based

on your title. You can come back and edit the alias later.

13
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Category: The category where you want you Article to reside. Select a previously created
category with the drop-down menu. You can move articles to other categories later if you wish.

Articles can live only in one category at a time.

Status: Joomla! offers several states for your Article.
Published:  The article is accessible for viewing on the web site.
Unpublished: The article is not accessible for viewing on the web site.
Archived: This is a special state that moves the Article to the Archives, where it is

still searchable and viewable.

Access: This lets you specify whom may see the article. You have three choices
Public: Everyone.
Registered:  Registered site users when logged in.

Special: Higher level users when logged in.
Permissions: This is an advanced topic and generally is not needed for basic Joomla! usage.
Leave it set to Set Permissions and don’t worry any about this until you are more comfortable

with some of Joomla!’s advanced features.

Featured: If you want your article to appear on the home page of your site, set this to Yes.

Otherwise leave it set to No.
Language: This is a somewhat advanced topic. Let’s assume your site is using only one
language —the language chosen when your site was installed. In that case you can leave

Language set to All.

ID: This is the unique numeric database ID automatically assigned to your article. You cannot

change this number. It’s displayed for your reference.

Article Text: This is where you add your page’s content.

14
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Publishing Options: This simply gives you some basic demographic information about your

article. You can change all values here except for Revison and Hits.

Tip
Publishing Options lets you set custom dates for Joomla! to start and end

publishing your articles.

Article Parameters: Here you are offered a variety of settings that you may want to include
with your published article. The default settings are Use Global. Go ahead and leave that setting
unless you want to override the global publishing parameters that you have set for all articles in

Article Manager Options (covered in the next section).

Leave the Read More value blank so that Joomla! can use its default text.

Leave Alternative Layout set to Use Global. This is an advanced topic that basic content

management need not be concerned with.

Metadata Options: refers to content seen and responded to mainly by search engines. The
values used here will not be seen by regular site users under normal viewing conditions. For
instance, you can add some keywords and a short description of your content in the respective
fields. There is no harm in leaving the fields blank and Use Global until you are more

comfortable with these settings.

Saving and Closing your Article
One thing a lot of new Joomla! users often ask is: What is the difference between Save, Save &

Close, Save & New and Cancel buttons in the Joomla! toolbar? You will usually encounter these
options when editing Articles and Menu Items.
* Save: simply saves any changes you’ve made while letting you remain in the editing
screen.
*  Save & Close: saves your changes, exits you out of the item and returns you to the main

listing.

15
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* Save & New: saves your changes, exits you out of the item and opens a new editing
window (i.e. you are in the process of adding several Articles at a time).

* Cancel: exits you from the editing screen without saving any changes.

Figure 2.6: Article Manager access via Control Panel (Manager level view)

Administration ¥ Joomlal
Site Content Components Help 4 None Logged-in frontend  #L 2 Logged-in backend =" Mo messages [ View Site o Log out
my » Last 5 Logged-in Users
B + Top 5 Popular Articles
Add New Article Category Manager Media Manager » Last 5 Added Articles
Edit profie

Joomlal® is free software released under the GNU General Public License. Version 1.7.0
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Figure 2.7: Article Manager access via menu navigation

Administration

Site | Content | Components Help

Article Manager L) Add New Article

Category Manager F
&) Featured Articles

Media Manager
Add Mew Article Article Manager Category

Figure 2.8: Article Manager: Add New Article screen

Administration ¥ Joomlal
Site Content Components Help <& None Logged-in frontend  #L 2 Logged-in backend = No messages [ View Site o Log out
' : i B B O
Article Manager: Add New Article v 24
0 Save Save & Close  Save &New  Cancel Help
New Article o .
+ Publishing Options
Title *
e Created by Select a User Select User
Alias Created by alias
Categaory General Info N -
gory o Created Date m
Status Published & Start Publishing 23
Access i %
= Finish Publishing I
Featured No %
Language All
» Article Options
1D 0 5
» Metadata Options
Article Text
B 7 U am ‘ =E=== | Styles ~ Paragraph -
iz i | i= | | L E Yy @wm
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Figure 2.9: Article Manager: add/edit article, Article Options pane

#» Publishing Options
v Article Options

Show Title

Linked Titles
Show Intro Text
Show Category
Link Category
Show Parent

Link Parent

Show Author

Link Authar

Show Create Date
Show Modify Date
Show Publish Date
Show Mavigatian
Show lcons

Show Print lcon
Show Email lcon
Show Voting
Show Hits

Show Unautharised Links

Fead More Text

Alternative Layout

¢ Metadata Options

Use Global
Use Clobal
Use Clobal
Use Clabal
Use Global
Use Clabal
Use Global
Use Global
Use Clobal
Use Clobal
Use Glabal
Use Clobal
Use Clabal
Use Clobal
Use Global
Use Clobal
Use Global
Use Clabal

Use Global
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Featured Articles

Who

Managers, Administrators, Super Users

What
Joomla! Articles that are published to the home page

Where
Content > Featured Articles

Details
Featured Articles are nothing more than Articles that have been told to display on the home

page. Displaying Articles to the home page can be done in one of two ways:

1) In the Article editing screen, set Featured to Yes and click Save.
2) On the Article Manager: Articles screen (Content > Articles), click the grey circle icon in
the Featured column. The grey circle will change to a white star on a blue circle

background giving you visual feedback that the article is displaying on the home page.

Figure 2.10: Featured Articles access via menu navigation

Administration

Site | Content | Components Help

Article Manager 3

Category Manager

) Featured Articles

Media Manager
Add Mew Article Article Manager Category
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Article Manager Options

Who

Administrators, Super Users

What

A modal window that contains global settings for how and what will display with your articles

Where

Content > Article Manager > Options

Details

The Article Manager Options is a dialogue box where you can conveniently set global options
for all Articles in one fell swoop. This is a good place to start setting up how you want your
articles to display. For instance, by default Joomla! displays a few demographic pieces of
information about an article, such as its author, date and time of the article’s creation, and its
parent category. Maybe you don’t want to display this information. The Article Manager Options
lets you hide these items for all Articles on your site. Keep in mind that the options you set
globally in the Article Manager Options can all be overridden on an article-by-article basis in the
Edit Article screen. The options can be customized further still in the Menu Manager. (We’ll

cover the Menu Manager in a subsequent chapter.)

Tip
The main thing to understand here is that just because you specify certain settings
globally in the Article Manager Options, you are never locked into those settings.

Joomla! lets you customize settings for individual articles or groups of articles in

other areas of the Admin.

Since, as promised, this book is not an in-depth guide to Joomla!, let’s not get burdened with
every detail of the Article Manager Options. It contains several tabs where you can set global
settings until your heart is content. To get things done quickly and move on, we will focus only
on the Articles tab. You can leave the default settings in the other tabs: Category, Categories,

Blog/Feature Layouts, List Layout, Shared Options, Integration, Text Filters, Permissions.

20
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Select the Articles tab and adjust the settings to your preference. If you are unsure of any setting,
leave it as is. As you can do in most areas of the Joomla! admin, if you hover the mouse pointer
over the field labels, a tool tip will display to help you understand what each field is about.
Again, you are not locked into any setting. On an individual article basis, you can override the

settings you are selecting in the Article Manager Options.

Once you are satisfied with your setting choices, click the Save & Close button at the top of the

dialog box. To exit without saving any changes, click Close.

Figure 2.11: Article Manager Options toolbar button

AY

Options

Figure 2.12: Article Manager Options > Articles tab dialogue box in modal window

% Article Manager Options Save  Save & Close  Cancel |
|
|

Articles Category Categories Blog / Featured Layouts List Layouts Shared Options Integration Text Fiters Permissions |

|

These settings apply for article layouts unless they are changed for a specific menu item. |

]

Choose a layout Default % :

— ]

Show Title O Hide @ Show |

Linked Titles ® No O Yes !

|

Show Intro Text O Hide @ Show |

. |

Show Category ® Hide O Show |

Link Category 2 Mo @ Yes I

|

Show Parent ® Hide O Show |

|

Link Parent @ No O Yes .
Show Author ® Hide O Show

Link Author ® Mo O Yes

Show Create Date @ Hide O Show
Show Modify Date @ Hide O Show
Show Publish Date ® Hide O Show

Show Navigation @ Hide O Show i

ol bl LT LTS
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Media Manager

Who

Managers, Administrators, Super Users

What

A storage location and file browser for images and other media

Where

Content > Media Manager

Details

The Media Manager is an area of Joomla! reserved for storing files, most notably images. You
can upload your own files to the Media Manager and then organize them according to folders
that you create. After you upload images, you can reference them in Articles and Modules for

display on your Joomla! web pages.

Ti
’ Depending on which content editor is in use on your Joomla! web site determines
how you insert images. If you’re using Joomla!’s default editor, TinyMCE, there
is a toolbar button for adding images. A popular third-party editor is the JCE
Content Editor, available via the Joomla Extensions Directory,

http://extensions.joomla.org. You can globally manage editors in the Global

Configuration.

It’s worth noting that the Media Manager has two views, Thumbnail View and Detail View. The
default is Thumbnail View but many Joomla! users find the Detail View easier to use because it
displays folders and files in a list rather than as thumbnails, which makes the view easier to scan
and navigate. Thumbnail View truncates long file and folder names and uses more screen real

estate.

The Media Manager has an Options area, but for basic Media Manager usage, you can leave the

default settings.
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Uploading a file with the Media Manager is fairly self-explanatory. You’ll find an Upload Files
parameters area near the bottom of each screen that allows you to browse files on your local
computer. The maximum file-size you can upload is also displayed (i.e. 10 MB). This limit

depends on your site settings and server restrictions, so it can vary from site to site.

Before you upload a file, you’ll want to already be in the folder where the file you are uploading
should reside. Note the file path field value just above the Create Folder button. This path is the
full server path of your Joomla! install, from the server root all the way to the folder you are
currently viewing. That path will vary from host to host. The part of the path that’s important for
you is from the images folder and everything to the right of it. In a default Joomla! install, the
images folder is in the web site root, so anything to the left of images refers to folders that are

outside of Joomla! itself.

Figure 2.13: Media Manager access via Control Panel (Manager level view)
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Figure 2.14: Media Manager access via menu navigation
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Menus

Who

Administrators, Super Users

What

Menus that you build to provide users a way to navigate your web site

Where

Menus > Menu Manager

Details

Joomla! Menus are a special kind of Module where you build links to the various content items
in Joomla! The Menu Manager controls all of your front-end site menus. A lot of the heavy

lifting in displaying content on your web site’s pages is handled by the Menu Manager.

Menu Items are the individual links in a menu. When you create new Menu Items, Joomla!
gives you lots of options and choices. Depending the choices you make in the Menu Manager

determines in large part how your target pages display.

Notice that when you display the Menus menu, you can browse to either the Menu Manager or
directly to specific menus (i.e. Main Menu). One of the existing menus should have a star icon in

it. The star indicates the “default” or “primary” menu on your site.

How to create a Menu Item that targets an Article
To add a Menu Item that targets an Article that you’ve created, simply navigate to the menu that

should display a link to your Article and click the New button in the Joomla! Toolbar.

The resulting editing screen presents you with several field and decisions. Let’s go over the most

important ones for adding a Menu Item that targets one of your Articles.
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In the Details pane the first thing you must do is choose a Menu Item Type. Click the Select

button to begin.

In the Select a Menu Item Type dialogue box, choose Single Article under the Articles section.
Clicking Single Article tells Joomla! that the type of Menu Item you want to create is one that
will link to an Article. Clicking Single Article also immediately returns you to the Menu Item

editing screen so that you can continue setting up your Menu Item.

Selecting the Menu Item Type is probably the single most important step when creating new
menu items. Depending on the Menu Item Type you choose, determines what other parameters
and choices are available to you. As you saw when selecting Single Article, there are many
different Menu Item Types. In time you will learn more about the other types. This exercise is
intended to merely introduce you to working with menus and their items in an effort to show you

the connection between Menu Items and what Joomla! displays on your web site.

Back in the New Menu Item editing screen we can continue setting the rest of our field values:

Menu Title: this is the human-readable name that will display in your menu. Try to keep the title

short (About Us, News, Sales Staff, etc.).

Alias: this is a browser-readable string based on your Menu Item’s name that can be used as part
of the URL. The alias should not contain any spaces. Use dashes or underscores in place of
spaces. Mixed case is ok, but all lower case is preferable. You may leave the alias blank and
Joomla! will insert an alias based on your Menu Title. You can come back and edit the alias

later.

Note: is an internal description for the Menu Item. You may leave this blank.

Link: should already be populated with something that starts with index.php? followed by some

text and symbols. This is what’s called the “Joomla! raw link” to your article. Although Joomla!
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displays the link for you, it cannot be edited. Changing the link would cause your new Menu

Item to break when followed.
Status: tells Joomla! if your Menu Items should be visible, published, or hidden, unpublished, on
the site. If you want to delete the Menu Item, choose “Trashed” to send it to the Menu Trash.

You can retrieve the Menu Item from the trash later.

Access: determines who can see your Menu Item: everyone, Public, registered site users once

logged in, Registered, or higher-level users, Special.

Menu Location: tells Joomla! in which menu your Menu Item should appear.

Parent Item: lets you decide if the Menu Item should be a sub-menu item or not.

Target Window: should be set to Parent so that your link will open in the same browser

window. If you wish to have the Menu Item open your content in a new browser window, choose

one of the other settings.

Default Page: Set this to Yes if you want the Article you’re linking to be the site’s home page.

Language: can be set to All (or choose a specific language).

Template Style: can be set to Default.

ID: cannot be changed. This is the unique numerical reference to this item in the database.

In the Required Settings pane, you must choose an Article to target. When you click the

Select/Change button, Joomla! opens a listing of all of your existing articles in a modal window.

Locate the Article you want this Menu Item to target and click the Article’s name.
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Article Options: lets you override the global settings for Articles when your Article is accessed
through this menu link. This is a powerful feature of Joomla! You may want your article to
contain demographic data or display certain information only when accessed through this Menu
Item. If you are unsure, leave all settings to Use Global so that your settings in the Article
Manager Options prevail. (See the Article Manager Options section for more details on

configuring global Article settings.)

All remaining options can be left alone for now. Feel free to look at the various options for, Link
Type Options, Page Display Options, Metadata Options, and Module Assignment for this Menu
Item, but don’t feel compelled to change anything about those settings for basic usage of the

Article Menu Item Type.

Figure 2.16: Menu Manager access via Control Panel (Administrator level view)
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Figure 2.17: Menus menu
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Figure 2.19: Menu Manager: New Menu Item main screen

Administration ¥ Joomlal

Site Users Menus Content Compenents Extensicns Help & Mone Logged-in frontend @ 2 Logged-in backend = Nomessages 0 View Site () Log out

Menu Manager: New Menu Item v (m L Q 3

Save Save & Close  Save & New  Cancel Help

Details
+ Link Type Options
Menu ltem Type * Select
Link Title Attribute
Menu Title Link CSS Style
Alias Link Image Select | Clear
Note Add Menu Title O No e
Link Yes
Status Published ¥
i i
Access Public i » Page Display Options
Menu Location * Main Menu % » Metadata Options
Parent Item Menu Item Root $ » Module Assignment for this Menu Item
Target Window Parent :
Default Page ® No ]
Yes
Language All s
Template Style - Use Default - 3
D 0

Joomlal® is free software released under the GMU General Public License.  Version 1.7.0

30



Chapter 2

Figure 2.20: Select a Menu Item Type modal window
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Figure 2.21: Single Article menu-item type selection
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Figure 2.23: Single Article menu item type Required Settings pane

» Required Settings

Select Article ©
Select / Change

» Article Options

» Link Type Options

» Page Display Options
» Metadata Options

» Module Assignment for this Menu ltem

Lelect an Article

33

Chapter 2



L 4

Figure 2.24: Single Article menu item type Article Options pane
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Chapter 3: Components, Modules and Plug-ins a.k.a. “Extensions”

Joomla! Extensions are sub-programs that perform specific tasks, and are the heart and soul of
how Joomla! works. In addition to Joomla!’s “core extensions” that ship and install with
Joomla!, third-party extensions can be installed to enhance your site’s functionality. Visit the
Joomla! Extensions Directory (JED) to see a complete listing of third-party extensions available

for your site, http://extensions.joomla.org.

35



Chapter 3

Plug-ins

Who

Administrators, Super Users

What

Mini programs inside Joomla!

Where

Extensions > Plug-in Manager

Details

Plug-ins are a special kind of mini program that extends the functionality of Joomla! Plug-ins
are sometimes “seen” and sometimes not. What this means is that Plug-ins can control both
visible assets in your web site, or may provide some script that simply runs in the background
supporting modules, components or other areas of your Joomla! site. Plug-ins can be enabled or

disabled.

Figure 3.1: Plug-in Manager access via menu navigation
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Modules

Who

Administrators, Super Users

What

Small chunks of functionality or content that are assigned to various locations on your site

Where

Extensions > Module Manager

Details

Modules are Joomla! extensions that let you display small pieces of content, i.e. a “feature box,”
or offer functionality, such as a login form or search-site field. Modules are assigned Template
Positions” that determine where on a page to display. In addition, Modules can be assigned to

specific pages based on menu assignment.
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Figure 3.2: Module Manager access via Control Panel (Administrator level view)

Administration ¥ Joomlal’

Site Users Menus Content Components Extensions Help “& None Logged-in frontend %L 2 Logged-in backend = Mo messages [ View Site o Log out

. S my » Last 5 Logged-in Users
[+ ] _— » Top 5 Popular Articles

Add New Article Avticle Manager Category Manager Media Manager b Last 5 Added Articles

—_— 0
Menu Manager User Manager Meodule Manager Extension Manager

Language Manager Template Manager Edit profile

Joomlal® is free software released under the GNU General Public License.  Version 1.7.0

Figure 3.3: Module Manager access via menu navigation
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Components

Who

Administrators, Super Users

What

Sub-programs within Joomla! that provide major functionality

Where

Components > [Component Name]

Details

Larger and more versatile than Plug-ins or Modules, Components are full-blown programs that
can vastly extend the features of your web site. Components can be small, like the Web Links
component, one of Joomla!’s core components, or they can be large and let your site have

advanced functional areas, such as a forum, social network or a shopping cart.

Figure 3.4: Joomla! core and third-party components access via the Components menu
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Chapter 4: Introduction to a few Advanced Topics

As promised, this book is not an in-depth guide to Joomla! The point of this book is not to bog
you down in highly technical explanations or lengthy tutorials about Joomla!. However, it is
helpful even for content managers to understand, at least in overview, the technical context of the
content you’re managing. For instance, your content has a certain “look and feel” that is
determined by your site’s Template. Your web site’s pages might have sophisticated behavior
that’s controlled by sub-programs that are managed with the Extensions Manager. And whether
you are managing content or controlling system settings, you must be a Joomla! User. Last but
not least, how your Joomla! site behaves, indeed even its title, is dependent on settings specified
in the Global Configuration. This chapter introduces these concepts to enrich your understanding

of Joomla!’s advanced features.
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Templates

Who

Administrators, Super Users

What

Management of web site look-and-feel design and interface behavior

Where

Extensions > Template Manager

Details

Templates determine the look and feel of you web site. It’s the actual “design” of the site, but
templates can be more than that. Templates can offer additional functionality to your site, and
many templates do. Fundamentally, Templates control your site’s look-and-feel and let you

adjust certain aspects of it, like font colors, background textures, and so on.

Figure 4.1: Template Manager access via Control Panel (Administrator level view)
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Figure 4.2: Template Manager access via menu navigation
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Install/Uninstall and Managing Extensions

Who

Administrators, Super Users

What

Allows installation and un-installation of templates and extensions

Where

Extensions > Extensions Manager

Details

The Install/Uninstall area of the Joomla! admin is where you can upload and install extensions
and templates. This area also lets you uninstall templates and extensions. The Extensions
Manager: Install screen is the first one you see when you access the Extensions Manager, but
this screen contains several other areas to view, Update, Manage, Discover and Warnings. The
only other one we’ll introduce at this point is the Manage screen. Click its name and the
Extensions Manager shows you every extension installed on your Joomla! site. From this screen
you can change an extension’s status, and even remove extensions all together. Feel free to view
the other screens to see the type of information the Extensions Manager has available for you. To
exit the Extensions Manager, simply browse back to the Control Panel via Site > Control Panel,

or click the Administration heading above the menu bar.
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Figure 4.3: Extensions Manager access via menu navigation

Administration

Site Users Menus Content Components | Extensions Help

|u Extensicn Manager

Module Manager
0 & Plug-in Manager

Add Mew Article Article Manager Category \{ Language Manager oer

—  Template Manager

Figure 4.4: Extensions Manager: Install screen
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Figure 4.5: Extensions Manager: Manage screen
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Users

Who

Administrators, Super Users

What

Allows management of Joomla! users

Where

Users > User Manager > [User Name]

Details

The User Manager allows management of all Joomla! users in your system, including a user’s
Name, Login Name, Password and Email. Two settings that are particularly interesting are

Receive System Emails and Block User.

Receive System Emails: can be set to yes for administrators who are responsible for monitoring
site activity. This will allow the administrator to receive notification if someone registers for the

site and other system messages that Joomla! may be configured to send.

Block User: does exactly what the title says. It disables a user. Sometimes it may be desired to

simply disallow a user to access your site instead of deleting the user. An example of this might
be if you’ve hired a contractor for a short time. You can allow or disallow the contractor access
to your site based on the time that s/he is in your employ. This is a simpler workflow than

deleting and re-creating the contractor’s account.

Assigned User Groups: This is where you determine what access a user should have. There are
two main groups of users, those who have access to the Admin site, “back-end” or “admin-site
users,” and those who have access only to the “front end” web site.

User Groups and a brief description of what each type can do:

* Manager: Can access the Admin site and manage content-related items only.
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*  Administrator: Can access the Admin site and manage everything except system items.

*  Super User: Can access the Admin site and manage everything including system items.

* Registered: Regular site user who has a basic profile and log-in on your site’s front-end.
When logged in Registered users can be served content that is not available to everyone
(“guests”). Registered users cannot add, edit or publish content, and cannot access Admin
site.

*  Author: Cannot access Admin site, but is allowed to author content via the front-end site
after logging in.

e FEditor: Cannot access Admin site, but is allowed to edit content via the front-end site
after logging in.

*  Publisher: Cannot access Admin site, but is allowed to edit and publish or unpublish

content via the front-end site after logging in.

Basic Settings: can be left alone for the purposes of basic Joomla! user management.

Note that assigning users to groups is possible only to the level of the user doing the changing. In
other words, Administrators can manage and reassign other Administrators and lesser groups.
Administrators cannot manage Super Users, but an Administrator can elevate a Registered user

to Administrator.
Super Users can manage all users in any group—including other Super Users. This is a very

powerful feature, so you should only grant Super User privileges to individuals that you trust

explicitly.
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Figure 4.6: User Manager access via Control Panel (Administrator level view)

Administration ¥ Joomlal’

Site Users Menus Content Components Extensions Help “& None Logged-in frontend %L 2 Logged-in backend = Mo messages [ View Site o Log out

S my » Last 5 Logged-in Users
[+ N— » Top 5 Popular Articles
Add New Article Article Manager Category Manager Media Manager b Last 5 Added Articles
—_— 0
e «)= @
Menu Manager User Manager Meodule Manager Extension Manager

& = O

Language Manager Template Manager Edit profile

Joomlal® is free software released under the GNU General Public License.  Version 1.7.0

Figure 4.7: User Manager access via menu navigation
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Figure 4.8: User Manager: Edit Profile screen
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Global Configuration

Who

Super Users

What

Allows editing of the global configuration file via a graphical user interface (GUI)

Where
Site > Global Configuration

Details

Critical site settings are managed from the Global Configuration, which is why only Super
Users have access to this area. The Global Configuration manages settings that affect everything
from the site name to session settings to permissions to database connection details. Most new
users of Joomla! —and certainly users whose main role is to manage content— should not need

access to the Global Configuration.
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Figure 4.9: Global Configuration via Control Panel (Super User level view)
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Figure 4.10: Global Configuration via menu navigation
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Conclusion

Conclusion

At this point you should have enough of an understanding of Joomla! to add, edit and display
content on your web site. We encourage you to continue exploring and learning Joomla! CMS.
With its wide use and popularity, you will find a lot of community support and more detailed

sources for learning Joomla! to any level you like.

Resources for support and continued learning

Joomla! documentation’s site. Best source for detailed instructions: ........... http://docs.joomla.org
Joomla! MAIN SIEE: ...eiiiiiiiiiiiiiiiiiiee e e e e http://joomla.org
Joomla! fOrumS: .......cooiiiiiii e http://forum.joomla.org
lynda.com video tutorials: ...........cccoiiiiiiii e, http://lynda.com

YouTube! Yes, YouTube has an array of Joomla! “how to” videos: .................. http://youtube.com







